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Overview 
 DiCentra should install straightforwardly on Windows 7, Windows Vista, Windows XP, 

Windows 2000, and other reasonably recent versions of Windows.  It has been tested 
on Windows 7, Windows Vista Home Premium, Windows XP and Windows 2000.  

 DiCentra uses something called ‘The .NET 1.1 Framework’ from Microsoft.  Please 
note, that you will still need this even if you have a later .NET Framework on your 
machine, e.g. 2.0 or 3.5.  It can be easily installed (see below). 

Getting DiCentra from the Web 
 The DiCentra installation package is about 8 MB in size.  If you have a broadband 

connection it can be downloaded from: 

www.wilburimaging.com/dicentra  

 Updates will be posted there from time to time. 

 Should you need it, the .NET 1.1 Framework is available from the Microsoft site.  
There is a link on the above web page to get it. It is 23MB in size.  Even if your 
machine already has .NET 2.0, .NET 3.0 or .NET 3.5 you will need .NET 1.1.  They 
are all different packages, not just different versions, despite their names. 

Getting DiCentra by post 
If you only have a dial-up connection you may prefer to get a copy on CD together with a 
copy of the .NET 1.1 Framework. To do so, please see the form at the end of this 
document and send it with an appropriate cheque to us.   

Trial Version Limitations 
When you install DiCentra initially it only has limited facilities and will only allow you to 
make competitions with at most 3 entrants, each with at most 3 images.  Also, until you 
purchase a full licence you will not be able to use the projector set up facilities. 

User Guide 
The DiCentra User Guide is installed with the software.  It contains details of all features 
and can be found at: 

Windows Start > All Programs > DiCentra > User Guide R3.pdf 

 

Installing DiCentra for the First Time 

General 
You need Administrator privileges to install or uninstall applications including DiCentra on 
Windows XP, Vista and Windows 7.  Your normal login account will probably have such 
privileges, but if not, log in to a suitable account before trying to install or uninstall 
DiCentra. 

Windows 7: DiCentra uses the .NET Framework 1.1.  When you attempt to install it on 
Windows 7 you will get a message indicating it is incompatible.  Just ignore this 
message and continue with installation. 

Windows Vista: Vista tries to prevent you from installing software that might be insecure 
by displaying a dialogue with  

Unidentified Program Wants to Access Your Computer 

in large letters.  When this happens, click on the Details button and if you see comforting 
words like Microsoft, Wilbur Imaging or DiCentra in the details you can safely click  

Allow 
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Network Installation 
If you downloaded DiCentra from the web 

1. Extract the files from the .zip file. 

2. Double-click the Setup.exe file and installation will begin. 

3. If you get a dialogue saying “Welcome to the DiCentra Setup Wizard” go to step 7 
below. 

4. Otherwise you will probably get the message: 
“This Setup requires the .NET Framework version 1.1.xxx. Please install the .NET 
Framework and run this setup again. The .NET Framework can be obtained from the 
web. Would you like to do this now?” 

and you will need to install the .NET Framework.  

5. Download it from the Microsoft site by clicking on the link on the DiCentra download 
page and follow the instructions.  After unzipping it if necessary, install it by double-
clicking on:  

dotnetfx.exe 

(If you do not use the link on the DiCentra download page, do ensure that you are 
downloading the “1.1” Framework, and not the “2.0”, “3.0” or “3.5” Framework.) 

6. Once that has completed, double-click on the DiCentra Setup.exe file again and you 
should now get the Welcome dialogue. 

7. Click on Next and select Everyone to install DiCentra for all user accounts on your 
machine. Then click Next. 

8. Read the licence agreement and if you agree, select ‘I Agree’ and then click Next. 

9. Click Next to start the installation and once it has completed click Close. 

DiCentra is now installed on your machine and you will see a shortcut on your desktop and 
in your Start menu. 

Installation from CD 
1. Load the CD in a suitable drive. 

2. Double-click the Setup.exe file and installation will begin. 

3. If you get a dialogue saying “Welcome to the DiCentra Setup Wizard” go to step 7 
below. 

4. Otherwise you will probably get the message: 
“This Setup requires the .NET Framework version 1.1.xxx. Please install the .NET 
Framework and run this setup again. The .NET Framework can be obtained from the 
web. Would you like to do this now?” 

and you will need to install the .NET Framework.  

5. Double-click on:  

dotnetfx.exe 

on the CD to install the .NET Framework. 

6. Once that has completed, double-click on the DiCentra Setup.exe file again and you 
should now get the Welcome dialogue. 

7. Click on Next and select Everyone to install DiCentra for all user accounts on your 
machine. Then click Next. 

8. Read the licence agreement and if you agree, select ‘I Agree’ and then click Next. 

9. Click Next to start the installation and once it has completed click Close. 

DiCentra is now installed on your machine and you will see a shortcut on your desktop and 
in your Start menu. 
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Documentation and Samples 
 DiCentra will run in trial mode until you buy and install a licence.  In trial mode you are 

limited to building and running competitions with at most 3 entrants and at most 3 
images per entrant.  You will not be able to run the projector setup functions either.  
You should be able to use all other features. 

 Once you have installed DiCentra, the Windows Start menu contains a folder called 
DiCentra.  In it you will find a link to the User Guide and Release Notes. You will 
need Adobe Acrobat Reader to read these files, and if you do not have it already there 
is a link on the DiCentra download page in order to obtain it. 

 When you first start DiCentra it installs sample rules for: 

a. a club competition  

b. an inter-club competition, and 

c. open competitions with and without club names. 

 A folder called ‘DiCentra’ is also installed in your ‘My Pictures’ folder and you will find 
six folders inside. These are sample images as follows: 

a. Folders CD 1 and CD 2 are for the club competition 

b. Folders CD 3 and CD 4 are for the inter-club competition 

c. Folders CD 5 and CD 6 are for the open competition (with club) 

d. Folder CD 7 contains samples for the portfolio competition, and 

e. Folder CD 8 contains examples of surname-first entries. 

 Hopefully, you will find these useful in familiarising yourself with the rules, assembling 
and running a competition. 

Quick Start 
To create a sample inter-club competition, proceed as follows: 

1. File > Open Rules and select ‘Sample Interclub Competition’ from the list 
This allows you to browse the rules that have been set up for this competition.  Click on 
each of the tabs to see the format that has been defined for file and folder naming and the 
marking rules. 

2. When you have finished, click Cancel. 

3. Setup > Load Entries and select the folder ‘Brightlees Camera Club’ by navigating to 
My Pictures > DiCentra > CD 3 in the dialogue box. Repeat for ‘Chelsea Globe PS’ on 
CD 4. 
DiCentra will check the files and if necessary adjust them to fit the rules. 

4. Setup > Make Competition. 
This will create and organise all the files you need to run the competition. 

5. Competitions > Run Competition will now start the competition. 
A title screen will appear. You need to use keystrokes to navigate from one image to the 
next (right-arrow or enter) or add marks (0-9 and ‘.’). The full range of keyboard functions 
are in Appendix B of the User Guide. Note: In the trial version the marks will not be saved. 

6. To stop the competition, right-click to bring up a menu and click Save and Exit. 
A number of features are accessible from the right-click menu. Indeed, DiCentra has been 
designed so that the most common features needed during a competition use the keys on 
the numeric keypad of the keyboard and the rest are available by right-clicking.  

7. If you have a licensed version and have entered marks when running the competition, 
use File > Reports to produce a detailed results sheet. 
This produces a ranked list of entrants and the marks and certificate awards for the 
individual images depending on the options you select. 

8. That’s it.  
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Creating and Running Competitions  

Basic Steps 
These are the steps involved in setting-up and running a DiCentra competition: 

Step 1: Create the rules.  The organiser chooses the name and sets rules for the 
competition, including whether it is a club or inter-club match and the marking 
scheme. 

Step 2:   Load entrants' images. DiCentra checks that they conform to the competition 
rules and will do its best to correct problems unless such correction is disallowed 
by the rules.   

Step 3:   Make the competition from the rules and the loaded images. 

Step 4:   (Optional) Export/import the competition to another machine for running the 
competition. 

Step 5:   Run the competition, entering the judge’s marks or holding back images. Held 
back images can then be marked at the end. 

Step 6:   Display and/or print the results. 

Chapter 3 of the User Guide (All Programs > DiCentra > User Guide R3 on the Windows 
Start menu) provides more detail on these steps. 

Other Samples 
Try creating your own competitions from the sample rules and images provided: 

 Sample Club Competition uses the images in the folders called CD 1 and CD 2 in the 
DiCentra folder in My Pictures. 

 Sample Open Comp – No Club also uses folders CD1 and CD 2 as sample entries.  
When you load the entries you will be asked to enter a club name for each entrant.  
Tick the Allow Blank Field box if you don’t want to provide one.  When you make the 
competition you will be asked how many entries from each entrant you want to use.  
This feature allows you to roughly control the total number of entries in an open 
competition. 

 Sample Open Comp – With Club uses folders CD 5 and CD 6 as sample entries.  

Portfolio Competitions 
Portfolio competitions are where a collection of images by an author are to be judged as a 
group.  Sometimes one mark is given to the collection, sometimes each image is marked and 
totalled and sometimes a combination is used.  DiCentra portfolio competitions allow for any 
of these.   

Because they are slightly different from other DiCentra competitions, here are a few notes that 
may be helpful: 

1. Rules: You set up rules in the usual way and choose Portfolio Competition as the 
competition type. 

2. Folder/File names: There are reduced options for file/folder formats and marking: 

a. The folder name must be the portfolio name followed by semicolon or 
underscore followed by the author's name, for example, ‘Evening Light; Fred 
Blake ARPS’ 

b. Each file in the folder must start with a number from 01 upwards indicating the 
desired order of presentation, followed by a space and that image's title (and 
.jpg or .tif as appropriate), for example, ’01 Sunset in Morrocco.jpg’ 

c. The marking scheme is always 'Marks' - you can't use place marking 

d. There are no tie-break policies to choose 
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e. Random can be selected as (none) which will present the portfolios in 
alphabetic order of their titles, or Once or Every Round which are identical and 
select the portfolios in random order (of course, the portfolio's images are still 
shown in the proper sequence order) 

3. Loading images: The portfolio folders from the entrants are loaded in the usual way, 
and DiCentra will create an extra image for each portfolio, the title image, containing 
its name. 

4. Making a competition: When you make the competition, you are given a choice as to 
whether you want the title images to be flagged as held back.  This is actually a way of 
allowing the start of each portfolio to be located quickly using the held back window at 
the bottom of the competition screen.   

5. Scoreboard: Particularly if you want the portfolio marks to be the sum of marks given 
to images it is worth setting the Ranked Portfolios checkbox in Scoreboard Options 
(Competition > Scoreboard Options).  When scores are shown on screen the sum of 
marks for each portfolio will be shown.  If Details are also checked then each 
portfolio’s images will be listed underneath. 

6. Running a competition: Running the competition is much like any other: any image 
can be marked or given an award.   

7. Portfolio marks: Also, the title image can be marked or given an award - for example 
the overall mark for the portfolio. 

8. Navigation: Individual portfolios can always be selected in the Navigator for normal 
viewing, a slideshow or in lightbox view.  If you flagged the title slides as held back 
when you made the competition you can use the held back window at the bottom of 
the competition screen to quickly locate the start of each portfolio. 

If there are only three or so images per portfolio you may find that opting to mark all title 
images as held back results in too much clutter, but even without marking them you can still 
find individual portfolios using the Navigator. 

At present the maximum mark that can be assigned is the same for all images.  Thus, if you 
want the images to be marked out of 10 and the panel as a whole to be marked out of 20 you 
will have to set the maximum mark in the rules to 20 and ensure that the scorer only marks 
images out of 10 but places marks out of 20 on the title image. 
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Installing the Licence 
When you purchase a DiCentra licence you will be provided with a user name which will 
generally be the name of your organisation, a licence key and a JPEG file. To install the 
licence: 

1. Run DiCentra from a Windows account with Administrator privileges. 

2. Help > Install Licence … to open the installation dialogue 

3. Type in your user name exactly as it was provided to you including capital letters and 
spaces between words. 

4. Type in your licence code including the hyphens between the groups. 

5. Unless it has been installed earlier you will be asked to locate the JPEG file that was 
provided. 

6. DiCentra will then copy this file to the relevant place. 

7. DiCentra will then check your credentials.  If all is well you will notice the DiCentra title 
screen has been replaced by one containing your organisation’s name, and the full 
range of menu items should now be available. 

8. You will need to repeat this procedure if you install DiCentra on another machine, so 
please keep your credentials, including the JPEG file somewhere safe. 

PLEASE NOTE: 

If you make any change at all to the filename or content of the JPEG file provided and try 
to use it, licence checking will fail and DiCentra will revert to the trial version. 

Installing an Update to DiCentra 
1. Use Control Panel > Add or Remove Programs or on Windows Vista use Control 

Panel > Programs > Uninstall a Program to remove the old version of DiCentra 

2. Follow the relevant procedure above for installing DiCentra from a network file or CD. 

3. After updating a licensed version of DiCentra to version 3.3.53 you must start it up 
once from a Windows account with Administrator privileges before trying to use it from 
a non-Administrator account.  This causes the licence credentials to be made available 
to all users. 

Installing an update will not over-write or delete any of your existing rules or competitions.  

Problems 
We are keen to get your feedback on DiCentra, and if you have things you would like to 
see in future versions please e-mail us at the address below. 

If you have problems please e-mail us at: 

software@wilburimaging.com 

giving details of your operating system and the symptoms, as well as your name and 
phone number. 

 
Steve Wilbur 
1st May 2010 
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Order Form for DiCentra 
   £ £ 
 Please provide me with DiCentra on a CD 

together with the Microsoft redistributable 
.NET 1.1 Framework.  

 

5.00  

 Please provide me with a licence for 
DiCentra 3  

 

35.00  

   Total  

 
Please make cheque payable to: ‘Wilbur Imaging’.   
 
Alternatively, if you would like to pay by credit card or PayPal, please e-mail me at 
software@wilburimaging.com so that I can issue a PayPal invoice. 

 

Name:  .......................................................................................................  

Organisation:  .......................................................................................................  

Address:  .......................................................................................................  

  .......................................................................................................  

  .......................................................................................................  

Phone:  .......................................................................................................  

E-mail:  .......................................................................................................  

 

If paying by cheque, please post to: Steve Wilbur, Wilbur Imaging, 29 Monks Orchard Road, 
BECKENHAM, Kent BR3 3BH 


